
Important information
Before you use the SMART Response™ interactive response system, please read and
understand the safety warnings and precautions described in this guide. These safety
warnings and precautions instruct you in the safe and correct operation of the system
and its accessories so you can prevent injuries to yourself, others or damage to the
equipment. Youmust always ensure that the SMART Response interactive response
system is being used correctly.

NOTE

If you own a SMART product other than a SMART ResponseXE interactive
response system, refer to the user’s guide that camewith your product for
relevant warnings andmaintenance instructions.

Safety information
WARN ING

l Failure to follow the installation instructions that ship with the SMART
product could result in personal injury or damage to the product.

l When using the SMART Response interactive response system with a
SMART Board™ interactive whiteboard and projector, do not stare into the
beam of light created by the projector. Instruct children not to look in the
direction of, or stare at, this beam of light.

l Ensure that any cables extending across the floor to your SMART product
are properly bundled andmarked to avoid a trip hazard.

l To reduce the risk of fire or electric shock, do not expose the components
to rain or moisture.
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CAUTION

l Use only the batteries provided or equivalent replacements. Do not attempt
to recharge the batteries.

l Do not install batteries with the polarity (+/–) reversed.

l Do not dispose of batteries in a fire or incinerator.

Dispose of batteries according to the laws and regulations of your region. If
you do not know the applicable rules for your region, consult the battery
manufacturer.

l Never use abrasive erasers or harsh chemicals when cleaning SMART
Response interactive response system hardware.

l Do not open the receiver or clicker units to attempt repairs. Refer all
service to authorized SMART service personnel.

I MPORTANT

l Youmust connect the USB cable that camewith your SMART product to a
computer that has a USB compliant interface and that bears the USB logo.
In addition, the USB source computer must be compliant with CSA/UL/EN
60950 and bear the CE mark and CSA and/or ULMark(s) for CAS/UL
60950. This is for operating safety and to avoid damage to the SMART
product.

l If your SMART product requires replacement parts, make sure the service
technician uses replacement parts specified by SMART Technologies or
parts with the same characteristics as the original.

Compliance
This device complies with Part 15 of the FCC rules. Operation is subject to the following
two conditions:

1. This devicemay not cause harmful interference, and

2. This devicemust accept any interference received, including interference that
may cause undesired operation.

Changes or modifications to this equipment not expressly approved by SMART
Technologies may void the user’s authority to operate this equipment.
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NOTE

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation.

This equipment generates, uses and can radiate radio frequency energy and, if
not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the followingmeasures:

l Reorient or relocate the receiver or clicker units.

l Increase the separation between the equipment and the product.

l Connect the affected equipment to an outlet on a circuit different from that
to which the receiver’s computer is connected.

l Consult your SMART service representative or an experienced radio/TV
technician for help.
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About SMART Response
I N TH I S SECT ION
Features 2
Software 4
Hardware – clickers and receivers 5

The SMART Response interactive response system is an assessment tool that
enhances learning. It facilitates summative and formative assessment by allowing you
to pose a question before, during or after a lesson to find out whether students are on
track. You can use the feedback to help shape the rest of your lesson.

Once you finish the lesson, create a question set with SMART Response assessment
software to evaluate learningmore formally. You can feel confident that the students
have answered the way they intended, because they can verify and change their self
paced responses directly on the clicker.

Teachers can easily add creativity to questions by combining text with images tomake
questions more dynamic. SMART Response comes with SMART Notebook
collaborative learning software, and offers 6,000 learning objects that you can easily add
to quizzes.

SMART Response also increases one-to-one interaction by allowing teachers to survey
and engage students and collect responses.

Chapter 1
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Features
Feature Description

Teacher Tools Access, view andmanage all assessment data in one
location. This powerful tool allows you to create class lists,
and set up, conduct andmanage tests and quizzes.
You can alsomonitor each student’s progress during a test
and instantly view their results.

Smooth integration SMART Response software integrates with SMART
Notebook.

New user interface With its simple interface, SMART Response’s intuitive
software allows you to create pages that have clear,
contextual and concise information for both novice and expert
users.

Integrated Gradebook ThroughGradebook, you can build comprehensive reports
based on your students’ grades, and you can sort, organize
andmonitor your students’ progress. Reports can be as
simple or as detailed as you need. Create high-level
comparisons of class performance, specific reports based on
tagged characteristics such as demographics or curriculum
standards, or personalized reports on how individual students
are doing.

Integration with third-
party question bank

You can easily integrate third-party questions into SMART
Notebook.

Tagging You can tag students and questions, and automatically
generate reports with comprehensive student and class
performance breakdowns.
You can also tag key words to describe various
characteristics, correlate questions to curriculum standards
and break down performance into a printable chart.
Teacher Tools makes it easy to keep everything organized.
The easy-to-usemanagement tool automatically files test
results in the built-in Gradebook. It also lets you view
performance reports and test scores, andmanage your class
lists, all from one location.

Ability to assign partial
points to answers

With this feature, you can assign partial points for individual
questions.
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Feature Description

Content pages You can use SMART Notebook page groups to present a
story on a content page, and then follow it up with relevant
questions.

One-window control of
classrooms and
assessments

Teacher Tools adds powerful grading and reporting
functionality. It brings your class lists and assessment
scores into one place, and automatically files assessment
results into Gradebook. Files save to a single .teacher file for
easier datamanagement.

Monitoring students
during and after the test
through the quiz
introduction page

You canmonitor how much time is remaining for a quiz
through the introduction page. Grades are immediately
calculated after the test and displayed in graphical charts and
numeric tables.

Monitoring time per
response and per
student

SMART Response’s interface can determine which student
answered first, and who answered what.

One-click instant
reporting through
Gradebook

Create one-click instant reports that display a student’s, or
class’s, performance and progress. Gradebook gives you
quick access to test results, making it easy to prepare reports
and conduct analysis.
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Software
Feature Description

Flexible assessment This feature gives teachers frequent opportunities to ask
questions and obtain feedback, which can engage students
more actively in thematerial they’re studying. You can
display feedback in a bar or pie chart. All feedback
statistically summarizes student responses, and helps
teachers record and track each student’s progress.

Anonymity Students can send private responses through the anonymity
feature. With this feature, the system logs each response
according to an assigned number for each student. Only the
teacher knows which student has which number, so
students can answer questions without feeling judged by
their peers.

Dynamic content Use SMART Notebook to create questions and
assessments with pictures, sound, video and
Adobe®Flash® Player compatible files from theGallery.

Instant, measurable
results

This feature allows teachers to instantly pose questions and
receive responses from within SMART Notebook.

Question variety Teachers can ask different types of questions, including true
or false, yes or no, multiple choice, multiple answer, numeric
fraction or expression response and text answer.

File import and export This feature allows teachers to export to their online
performance reporting systems, or a reporting system of
their choice.
Convenient monitoring options allow teachers tomonitor
students during and after tests, see how much time is left,
who has completed the questions, who answered first, and
which questions were answered.
The comprehensive Gradebook allows teachers to create
new class lists, conduct SMART Notebook assessments,
and view class reports.

Import and export
assessments

Teachers can export assessment results to other
gradebooking or database applications. They can also
import scores from other activities and quizzes to include in
SMART Response’s Gradebook for complete reporting.
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Hardware – clickers and receivers
Feature Description

Radio frequency
(RF) technology

RF technology provides a reliable wireless connection between
the student clickers and the central receiver. You don’t need a
line of sight to the clickers.
The receiver verifies receipt of every signal, andmessages are
automatically resent if they weren’t received.

100' (30m) range With a good RF path, the student clickers and central receiver
can connect within a 100' (30m) range.

Ergonomic design Designed to fit comfortably in young hands or lie flat on a desk,
responding to questions is quick and easy.
Even young students will find the handheld devices easy to use
and comfortable to hold.

LCD screen The easy-to-read LCD screen has room to display several lines
of text. Students can see whether responses have been sent
and review the status of their clicker’s battery power and
network connection.

Descriptive icons Icons on an LCD screen allow students to monitor battery power
and the network status of their clicker.

Extended battery
life

Each clicker uses long-lasting AA batteries.

Easy connection The receiver connects via a USB cable to a computer, and it
doesn’t require an additional power adapter.

Flexible installation The receiver weighs just under 6 oz. (165 g) and easily mounts
onto walls, desks or tables.

Status features The LED lights indicate power status and whether information is
being sent or received.

Compatibility SMART Response is compatible with both theMicrosoft®
Windows® operating system andMac OS X operating system
software.
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Environmental requirements
Before installing or using your SMART Response system, review the following
environmental requirements and compliance statements.

Temperature
SMART Response’s components can operate in the temperature range of 41°F to 95°F
(5°C to 35°C). In addition, the product can withstand storage temperatures from -40°F to
120°F (-40°C to 50°C).

Humidity
SMART Response’s system components can operate in up to 80% relative humidity
non-condensing.
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Water and fluid resistance
SMART Response’s components are for indoor use only and don’t meet any salt-spray
or water-ingress requirements. Don’t pour or spray any liquids directly onto SMART
Response components. These liquids could get into areas where they could damage
sensitive electronic components.

Dust and Scratching
SMART Response components are for use in office and classroom environments, and
aren’t for industrial use where heavy dust and pollutants can causemalfunctions or
impaired operation. They’re designed for pollution degree 1 (P1) as per EN61558-1,
which is defined as “No pollution or only dry non-conductive pollution.”

Electrostatic discharge (ESD)
SMART Response components meet the requirements of EN61000-4-2 severity level 4
for direct and indirect ESD. Nomalfunction or damage up to 15 kV (both polarities) with a
330 ohm, 150 pF probe (air discharge). Unmated connectors meet 8 kV for direct
(contact) discharge.

Conducted and radiated emissions
SMART Response hardware’s narrowband radiated electric field meets the limits for
Class B performance, as defined in EN55022/CISPR 22.

Computer requirements

Windows operating systems
l Pentium III 750MHz or later processor

l 512MB of RAM (1GB recommended)

l 750MB of free hard disk space for minimum installation (2150MB for full
installation with Gallery collections)

l Windows XP, Windows Vista orWindows 7 operating system

l Internet Explorer Internet browser 6.0 or later

l Adobe Flash Player 10 or later

l Adobe Reader 8.0 or later
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l Microsoft DirectX application programming interface 8.1 or later (required for
SMART Video Player)

MacOSX operating system software
l 1GHz PowerPC G4 or G5 processor or Intel processor (universal binary)

l 512MB of RAM

l 700MB of free hard disk space for minimum installation (1500MB for full
installation with Gallery collections)

l Mac OS X 10.5.x or 10.6.x operating system software

l Safari application program 3.0.4 or later

l Adobe Flash Player 10 or later

NOTES

l 1MB = 1024² bytes, 1 GB = 1024³ bytes

l SMART Response assessment software runs on 32-bit operating systems
only.

l You're unable to use SMART Response onWindows computers with Intel
Itanium processors.

Installing SMART Response software
To install SMART

Response software on a
Windows computer

1. Insert the SMART Response DVD into your computer’s drive.

If the SMART Response installation wizard doesn’t appear, browse to and double-
click theCDBrowser.exe file on the DVD.

2. Click Install SMART Response Software to start the wizard, and then follow the
on-screen instructions.

To install SMART
Response software on a

Mac computer

1. Insert the SMART Response DVD into your computer’s drive.

2. Double-click theSMART Response DVD icon.

3. Double-click theCDBrowser icon.

4. Click SMART Response Software, click Continue, and then follow the on-
screen instructions.
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NOTES

o You can install SMART Response for Mac computers without
installing SMART Drivers. Youmust install SMART Drivers if you
are using SMART Response with a SMART interactive product.

o If you want to install the Gallery content, or if you want to download
and install SMART Product Drivers, your computer must have an
Internet connection.

Connecting hardware and activating
SMART Response
To send information to and receive information from SMART Response clickers, you
must connect the SMART Response receiver to your computer. You can then check the
receiver's status in Teacher Tools.

I MPORTANT

Youmust register your SMART Response assessment software within 30 days
of installation to keep it active. SMART Response software automatically
activates when you connect your SMART Response receiver. If the activation
isn't successful, use themanual procedure in this section to find your license
code and activate the software.

NOTE

If you are using SMART Response in CE or VE mode, which doesn't require a
receiver, see Activating SMART Response CE for instructions.
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Connecting the receiver

I MPORTANT

l Do not connect the receiver to your computer until after you install SMART
Response.

l For operating safety and to avoid damage to the receiver, youmust only
connect the interactive whiteboard’s USB connector to a computer that
has a USB compliant interface and that bears the USB logo. In addition,
the USB source computer must be compliant with CSA/UL/EN 60950 and
bear the CE mark and CSA and/or ULmark (s) for CSA/UL 60950.

l The receiver has a USB 2.0 full-speed peripheral interface that runs at
speeds of up to 12Mbps. The unit works with USB 2.0- and USB 1.1-
compliant USB interfaces.

Recommended Height for Mounting the Receiver
Although SMART Response receivers don’t require an unobstructed line-of-sight
transmission path such as that required by infrared devices, you can operate SMART
Response over larger distances if youminimize interference, signal reflections and the
number and size of objects between the receiver and the clickers.

Choose a location for the receiver that’s as high as possible, and in plain view of the
students’ clickers. For permanent installations, use a USB extender to mount the
receiver high on a wall. Tominimize interference from other radio-frequency equipment,
position the receiver away from other wireless products, such as 2.4 GHz routers and
cordless telephones.

WARN ING

To prevent product damage or personal injury, route the USB cable where it will
not be stepped on or tripped over.

To connect the receiver 1. Position the receiver in an unobstructed location away from other wireless
products, such as 2.4 GHz routers and cordless telephones.

For temporary installations, place the receiver on top of your desk.

For permanent installations, mount the receiver on a wall or on the front of a piece
of furniture using two screws (not provided).
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o For temporary installations, place the receiver on top of your desk.

o For permanent installations, mount the receiver on a wall or on the front of a
piece of furniture using two screws (not provided).

Orient the receiver with the long side or edge facing the class as shown.

2. Insert the receiver's captive USB cable connector into an available USB
receptacle on your computer.

The Ready LED light on the receiver lights up to indicate that the receiver is
receiving power.

OnWindows computers, the first time you connect the receiver, a balloon
message appears from the notification area indicating that new hardware has been
detected.

I MPORTANT

If the balloonmessage indicates that Windows is starting to try to locate a
driver from theMicrosoft website, stop the search. If Windows can't find
the driver on your computer, you haven't installed SMART Response
software. Install the software and repeat the above procedure.

3. SeeChecking the receiver’s status on next page to verify that the receiver is
working properly.

Extending the USB cable
If the provided 6' (1.8 m) USB cable attached to the receiver isn’t long enough, use active
USB extender cables, USB extenders or hubs.

This graphic shows the SMART active USB extension cable (Part No. USB-XT).
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In some cases, you can use up to four cables to extend the length to about 80' (25m),
which is the limit of the USB specification. Passive USB extension cables aren’t
supported.

Alternatively, USB extenders that use Cat 5 cabling can extend the range to
approximately 325' (100m), at amuch higher cost. Themore economical SMART USB
extender pair (Part No. CAT5-XT) can extend the USB connection up to 120' (36.6m) on
Windows computers or 90' (27.5m) onMac computers using an RJ45 Cat 5 cable.

These units require that you use the provided 6’ (1.8 m) cables or use cables and
connectors that meet the same specifications. Impedancemismatches and poor
connections can cause signal degradation and performance problems.

NOTE

Some computers use internal active hubs to providemore USB receptacles. The
computer’s operating system could see these internal hubs as external devices,
limiting the number of USB extenders you can use.

Checking the receiver’s status
If you have connected the receiver and created a SMART Teacher file, you're ready to
start a class session. You can check the receiver’s communication status at any time
using the following procedure.

To check the receiver’s
status

1. Click theSMART Response icon in theWindows notification area or Mac
menu bar.
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A message appears below theConfigure Devices heading indicating how many
receivers are connected.

2. Click the icon below theConfigure Devices heading.

Teacher Tools starts.

3. Click theDevices button in the left column.

TheDevices window appears showing a status message.

4. If a “Your SMART Response receiver is connected and working” message
appears, the SMART Response receiver is connected and communicating with
the SMART Response software. The receiver name appears below theDevices
button.

Click My Receiver to display the classroom name and themake, model and
hardware ID (MAC address) of the receiver.

OR

If a “Your SMART Response receiver is not connected” message appears, the
SMART Response receiver isn’t connected or isn’t working properly. The receiver
name doesn’t appear below theDevices button.

Check the receiver connections or repeat the receiver installation. SeeConnecting
the receiver on page 11.

Activating SMARTResponse
Youmust register your SMART Response software within 30 days of installation to keep
it active. SMART Response software automatically activates when you connect your
SMART Response receiver. If the activation isn't successful, use the following
procedure to find your license code and activate the software.

Youmust connect your computer to the Internet and connect the SMART Response
receiver to your computer before you can search for a license code. After you complete
the following procedure to find your license code, you can use the code to activate
SMART Response assessment software on other computers, as outlined in the License
tab in theAbout SMART Response Assessment Software dialog box.

NOTE

After you find your license code, you don't need to connect the SMART
Response receiver to the other computers that you want to activate SMART
Response software on.
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To find your license code
and activate SMART

Response assessment
software

1. Click theSMART Response icon in theWindows notification area or Mac
menu bar, and then select Activate SMART Response Assessment Software.

TheSoftware Evaluation dialog box appears and displays the time remaining in
your software's evaluation period.

NOTE

If your SMART Response software is already activated, theActivate
SMART Response Assessment Software command is replaced by
Check for Updates. See the previous procedure to find the license code in
the activated software.

2. Click Activate Now.

3. If a dialog box appears requesting a password, type an administrator's password,
and then click OK.

NOTE

Contact your system administrator if you don't know your password.

4. Click Find License Code.

NOTE

Youmust connect your computer to the Internet and connect the SMART
Response receiver to your computer before you can search for a license
code.

5. Click Find License Code.

The license code appears. The activation program automatically copies your
license code into the License Code box.

NOTE

If you didn't connect the receiver, a warningmessage appears. Click OK to
close the dialog box.

6. Record the license code in a safe place, and then click Close.

7. Type your e-mail address in the License Code box, and then click Next.

Now that you have your license code, complete the following steps to activate
SMART Response software on other computers.

8. Your SMART Response assessment software activates.
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9. Click Finish.

Now that you have your license code, complete the following steps to activate
SMART Response software on other computers.

To find the license code
after the software is

activated

1. Click theSMART Response icon in theWindows notification area or Mac
menu bar, and then select About SMART Response.

2. Record the license code that appears on theDescription tab.

To activate SMART
Response assessment

software on other
computers

1. Click theSMART Response icon in theWindows notification area or Mac
menu bar, and then select Activate SMART Response Assessment Software.

TheSMART Response Software Evaluation dialog box appears and displays the
time remaining in your software evaluation period.

NOTE

You don't need to connect your SMART Response receiver during this
procedure

2. Click Activate Now.

If a dialog box appears requesting a password, type an administrator's password.

3. Type your license code and e-mail address, and then click Next.

4. Click Finish.

Your SMART Response assessment software activates.

Selecting how students answer questions
Students can answer questions using one of these available devices:

l SMART Response PE clickers

l SMART Response LE clickers

l SMART Response XE clickers

l SMART Notebook SE software on student computers

l SMART Response VE using PDAs

Each of these devices has a correspondingmode in SMART Response. When you or
your system administrator first installed SMART Response, you selected the
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appropriate mode for the devices in your classroom. You can change themode after
installation using the SMART Response Setup Tool. You can also operate SMART
 Response inMixedmode where you can use a combination of SMART Response
clicker types simultaneously.

NOTES

l Youmust have administrative privileges on your computer to use the
SMART Response Setup Tool.

l If you havemore than one type of SMART Response clicker available in
your classroom, you can chooseMixedmode, or you can choose themode
that matches the type of clicker you’re using, and then use only that type of
the clicker while in that mode.

l Different question types may not be available to different student devices.
SeeAbout question types on page 40 for more information.

l While you can use SMART Response LE clickers in Mixedmode,
students can only answer the first question of an assessment.

l Students can't use SMART Notebook SE (SMART Response CE) or
PDAs (SMART Response VE) while SMART Response is in Mixedmode.

To open the SMART
Response Setup Tool in

Windows operating
systems

1. Stop any running classes, and close SMART Notebook and Teacher Tools if
they're running.

2. Select Start > All Programs > SMART Technologies > SMART Response >
Setup Tool.

TheSMART Response Setup Tool window opens.

To open the SMART
Response Setup Tool in

Mac OS X operating
system software

1. Stop any running classes, and close SMART Notebook and Teacher Tools if
they're running.

2. In the Finder, browse to and double-click Applications/SMART
Technologies/SMART Response/SMART Response Setup Tool.

TheSMART Response Setup Tool window opens.
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To select how students
answer questions 1. Open the SMART Response Setup Tool.

2. Select one of the following options:

o SMART Response / Senteo

o SMART Response PE clickers

o SMART Response LE clickers

o SMART Response XE clickers

o SMART Notebook SE

o SMART Response VE for PDAs

o Any SMART Response clicker

NOTES

o SMART Notebook SE input isn't currently available for Mac OS X
operating system software.

o If you select SMART Notebook SE, you need to provide a SMART
Response CE product key after switchingmodes, even if you
previously activated SMART Response.

3. Click OK.

A message appears stating that your setup has changed.

When you start SMART Response, your students can answer questions using the
device you selected in step 2.

NOTE

The links to the SMART Response Help change to reflect the tool you
selected in step 2. For example, if you selected SMART Notebook SE, the
links point to the SMART Response CE Help.

If you kept this Help open when you selected the new tool, close the Help,
and then reopen it in the new mode.
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About SMART Response interactive
response system
Using the SMART Response interactive response system, you can perform planned or
spontaneous student assessments in the same software you use to deliver your
lessons—it integrates seamlessly with SMART Notebook collaborative learning
software.
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You can easily prepare exams in advance or spontaneously quiz students during a
lesson and receive immediate responses from your class. Depending on themode you
are using SMART Response assessment software, it supports several different types of
questions, including true or false, yes or no, multiple choice, multiple answer, text
answers, and numerical fractions and expressions. You can import questions from third-
party question banks, Microsoft applications and other commonly used software
programs.

After students submit their answers, you can instantly see the results by percentage in a
graphical format giving an accurate representation of the whole class's performance, not
just that of individual students.

Teacher Tools
Using Teacher Tools, you can access, view andmanage all assessment data in one
location. You can create class lists and set up, conduct andmanage tests and quizzes.
You can track each student's progress over several assessments and you can even tag
questions with key words to evaluate test results and student performance in greater
detail.

Teacher Tools make it easy for you to keep everything organized. The easy-to-use
management tool automatically files test results in the built-in gradebook. It also lets you
manage your class lists and view performance reports and test scores.

The Teacher Tools Gradebook gives you quick access to test results, making it easy to
prepare reports and conduct evaluations. Reports can be as simple or as detailed as you
need. Create high-level comparisons of class performance, specific reports based on
tagged characteristics such as demographics or curriculum standards, or personalized
reports on how individual students perform. You can also create reports that show
grades for the entire school year.

SMARTResponse hardware
The SMART Response receiver and clickers use radio frequency technology to provide
a reliable wireless connection between the student clickers and the central receiver. You
don't need a line of sight to the clickers, and the range is 100' (30m). The receiver
verifies receipt of every signal andmessages automatically re-send if they aren't
received.

Students will find the handheld clickers easy to use and comfortable to hold. Students
can easily read several lines of text on the large display screen. They can see if
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responses have been sent and review the status of their clicker's battery power and
network connection.

Using the interactive response system
You can purchase SMART Response interactive response system software for both
Windows andMac computers that meet theminimum specifications. SeeComputer
requirements on page 8 for information.

You can use SMART Response's integrated SMART Notebook features on any
computer, so you can take your laptop home to develop assessment questions without
having to connect a SMART Response receiver. You can then copy the assessment
files to a classroom computer where you can run your assessments.

When you install SMART Response, by default, the installation program installs SMART
Notebook software, SMART Product Drivers and SMART Response assessment
software. SMART Response assessment software includes Teacher Tools and new
menus that appear in the SMART Notebook toolbar. You can use the software free of
charge for 30 days after which youmust activate the software.

Asking Instant Questions
Use the Instant Question feature to introduce the SMART Response interactive
response system to your students. Instant Questions are individual questions you ask
spontaneously—they aren't part of an assessment. When you use Instant Questions,
you’re unable to type a question or assign a correct answer.

You can ask an instant question verbally, write it on an interactive whiteboard or type it
and add objects directly onto the SMART Notebook page.

NOTE

Make sure that you start your class and that all students are connected before
you ask instant questions

To ask individual
questions using the

Instant Question feature

1. Click theSMART Response icon in theWindows notification area or theMac
menu bar, and then select Open Notebook Software.

A blank SMART Notebook page appears.
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2. Click Insert Question on the toolbar.

T I P

If Insert Question isn't on the toolbar, you can right-click the toolbar and
add it.

3. Click one of the Instant Question buttons.

The Instant Question dialog box appears asking whether you want to insert the
question on this page or a new page.

4. Select one of the options.

T I P

If you want to use the same option by default, select theAlways perform
this action option. You can change the default in thePreferencesmenu.

A SMART Notebook page appears showing the possible answers to the question.
TheResponse tab changes toSingle Question, and theProgress button is
selected.

The question starts automatically, and appears on the clicker screens.

NOTE

If you haven't started a class, amessage appears asking you to select a
class. Select a class, and then click Start Class.

5. Present your question to the class.

6. After all students answer the question, click Stop this question.

7. To save the results, click .

To add another question without clearing the results of the previous question, don't
click Clear, and then repeat steps 2 to 5.

Setting up Teacher Tools
With Teacher Tools, you can:

l check the status and performance of the receivers, clickers and students

l select themode of operation

l manage class lists
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l start classes so that students can sign in with their clickers

l view historical information about the students and clickers

When you open Teacher Tools for the first time, you create a SMART Teacher file. You
can later edit the SMART Teacher file and adjust the privacy options.

Starting Teacher Tools
If this is the first time you're starting SMART Response, refer toSetting up Teacher
Tools on previous page for information.

When you start SMART Response it opens to the Gradebook view where you can create
or edit a SMART Teacher file, manage class lists, generate class or student
performance reports and perform many other tasks.

To start Teacher Tools Click theSMART Response icon in theWindows notification area or Mac menu
bar, and then select the icon below the Teacher Tools heading.

Teacher Tools appears in theGradebook view.

NOTE

If you have SMART Notebook open, you can also start it by pressingResponse
> Teacher Tools.

Creating a SMART Teacher file
The first time you start SMART Response, you need to create a SMART Teacher file
where you save all of your class lists and assessment results. Your SMART Teacher file
also enables your students to find and connect to your classes.

If needed, you can create additional SMART Teacher files after you create the initial one.

To create a SMART
Teacher file the first time

you use SMART Response

1. Click theSMART Response icon in theWindows notification area or Mac
menu bar, and then select the icon below the Teacher Tools heading.

TheWelcome to Teacher Tools wizard appears.

NOTE

The wizard appears only if you haven't created a SMART Teacher file yet.
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2. Type a classroom name of one to eight characters, and then click Begin.

AnAnonymous Modewindow appears showing the classroom name.

NOTE

If a receiver isn't connected, aSMART Response isn't ready window
appears. If you have a receiver, connect it now.

3. Click Create a new SMART Teacher file and set up your class lists.

A Gradebook Informationwindow appears.

4. Type your name and other information into the text boxes. TheSave button is
unavailable until you provide the Last name information. The other information is
optional.

5. Click Save.

A Save As dialog box appears.

6. Type a file name, and then click Save.

The .teacher file saves and theGradebook window appears displaying the
teacher’s name.

To create an additional
SMART Teacher file (after
you've created the initial

one)

1. Start Teacher Tools. SeeStarting Teacher Tools on previous page

Teacher Tools appears.

2. Select File > New.

TheGradebook Information screen appears.

3. Type your information in the fields provided, and then click Save.

Browse to the folder where you want to save your SMART Teacher file, and then
click Save.

Editing your SMART Teacher file
The first time you use SMART Response, youmust create a .SMART Teacher file that
lets your students find and connect to your classes. SeeCreating a SMART Teacher file
on previous page.

You can use the following steps to change the information in your SMART Teacher file.
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To edit your SMART
Teacher file 1. Start Teacher Tools. SeeStarting Teacher Tools on page 23.

Teacher Tools appears.

NOTE

You're unable to edit your classroom name if a class is started.

2. Click Edit (the blue underlined text beside the Gradebook name).

TheEdit Gradebook Informationwindow appears.

3. Edit the information, and then click Done.

Adjusting Privacy and Alert options
You can set the level of student information that appears on your display and define
whether you want student sign-in and sign-out alerts to appear.

Using Privacy mode
By default, SMART Response displays student information such as ID numbers and
grades. If you don't want to display sensitive information in front of your class you can
turn Privacy mode on

To display privacy
information

Click thePrivacy: Off button in the upper right corner of the screen.

To hide privacy
information

Click thePrivacy: On button in the upper right corner of the screen.

Changing Alerts
You can set SMART Response to display an alert message on your screen when
students sign in or out.

NOTE

Alerts only appear when the SMART Response Desktopmenu is running.

To set sign-in and sign-out
alerts

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23.

Teacher Tools appears.
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2. Select Edit > Preferences (Windows) or Teacher Tools > Preferences (Mac)
from themenu bar.

TheSMART Response Preferences dialog box appears.

3. Click theAlerts tab.

4. Select or clear the check boxes for the alerts you want to display or hide, and then
click OK.

Creating a Class List
Before you can start a SMART Response class in Sign Inmode, youmust have a class
list. You can use Teacher Tools to create a list, or you can import one fromMicrosoft
Excel or a comma separated values (CSV) file.

NOTE

You don't need to create a class list if you're starting the class in Anonymous
mode. For more information seeAbout Sign In and Anonymous modes on page
52.

Creating a Class List in Teacher Tools

To create a Class List
1. Start Teacher Tools. SeeStarting Teacher Tools on page 23

Teacher Tools appears.

2. Click Add a Class in theGradebook area on the left.

3. Type a name for your class (for instance, Math), add any optional details in the
Class Information boxes, and then click Add.

After a short delay, the new class's window appears, and the class name appears
in theGradebook area.

4. Click theStudents tab at the top of the window.

5. Click Add on the toolbar.

TheProperties window appears below the table.

6. Type a unique number of 1 to 15 digits in theStudent ID box.
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7. Type a student's name in theName boxes. The student's e-mail address and tags
are optional. You can also type name and ID information directly in the table.

NOTE

You can use tags to categorize the students in custom groupings that
SMART Response uses when you create student reports.

The student information saves to theClass List as you type it.

8. Repeat these steps for each student.

Importing a list from Excel

NOTE

This feature is supported by SMART Response software forWindows operating
systems only.

If you useMicrosoft Excel software tomaintain class lists, you can import an .xls or
.xlsx file into Teacher Tools to create a SMART ResponseClass List. Youmay find it
easier to copy the list of names in your current Excel document into a new spreadsheet.

To create a class list in an
Excel spreadsheet

1. Open the Excel spreadsheet containing your students' names.

2. Insert a blank row at the top of the spreadsheet if it doesn't already have one.

3. Type ID Number in the first cell (A1).

4. Type First Name in the first cell of the second column (B1), .

5. Type Last Name in the first cell of the third column (C1).

6. Move the first and last names into columns B and C, directly below the headings.

7. Type a unique ID number of 1 to 15 digits, for each student, in column A, and then
save the spreadsheet.
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To import a class list from
an Excel spreadsheet 1. Start Teacher Tools. SeeStarting Teacher Tools on page 23

Teacher Tools appears.

2. Click Add a Class in theGradebook area on the left.

3. Type a name for your class, add any optional details to theClass Information
boxes, and then click Add.

After a short delay, the new class's window appears, and the class name appears
in the Gradebook area.

4. Click theStudents tab at the top of the window.

5. Click the Import button at the top of the window, and then select Students.

The Import dialog box appears.

6. Select the class you want to import the student list into, and then click Next.

7. SelectMicrosoft Excel from the Import from: list, and then click Next.

8. Browse to and select the .xls or .xlsx file containing the class list, and then click
Open.

After a short delay, the names and IDs from the spreadsheet appear in the
Students page. You can now edit each student's properties, as required.

Importing a list from aCSV file
If you use a database or spreadsheet program tomaintain class lists, youmay be able to
export class lists as comma separated values (CSV) files. Refer to your database or
spreadsheet program's Help or user's guide for more information.

To create a class list in
CSV format

After exporting your class list as a CSV file, format your file in a text editor so that the
first three values are ID Number, First Name and Last Name as shown in this
example.
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Formore information, seeCSV file formatting below

To import a class list from
a CSV file

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23

Teacher Tools appears.

2. Click Add a Class in theGradebook area on the left.

3. Type a name for your class, add any optional details to theClass Information
boxes, and then click Add.

After a short delay, the new class's window appears, and the class name appears
in theGradebook area.

4. Click theStudents tab at the top of the window.

5. Click the Import button at the top of the window, and then select Students.

The Import dialog box appears.

6. Select the class you want to import the student list into, and then click Next.

7. Select Comma Separated Values (CSV) from the Import from: list, and then
click Next.

8. Browse to and select the CSV file containing the class list, and then click Open.

After a short delay, the names and IDs from your CSV file appear in theStudents
page. You can now edit each student's properties, as required.

CSV file formatting

Tips for formatting CSV files for importing class lists
The following is the general format you should use for CSV files:

ID Number,First Name,Last Name

12345,David,Jones

67890,Jane,Doe

56789,John,Swartz

34567,Mary,Smith
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The order of the columns isn't important, but the first row must contain the column
headings identifying what's in each column.

l Youmust have a columnwith the heading ID Number.

o Youmust put a single space between ID andNumber.

o In place of ID Number, you can use ID, Student ID orNumber.

o If you don't use a correct column name for the ID Number, the software is
unable to import the list.

l Specify student first and last names in separate columns.

o For the student's given name, use First Name for the column heading.

o For the student's family name, use Last Name as the column heading.

o Youmust put a single space between First (or Last) andName.

o In place of First Name, you can useGivenName.

o In place of Last Name you can use Last, Family Name orSurname.

l You can also use the heading Full Name to import a single value that combines
the first and last names.

o Youmust put a single space between Full andName.

o In place of Full Name, you can use Full orName.

o If you use Full Name, the software checks to see whether the first and last
names are separated by a comma (Last, First). If there isn't a comma, it
separates the names with a space (First Last).

o If you put three or more names with spaces between them, the software
uses the last word as the last name and joins all of the first words to form
the first name. For example, "Michael John Smith" is split with the last
name as Smith, and the first name as Michael John.

NOTE

If your spreadsheet or database software automatically inserts quotationmarks
around the comma separated values, the software ignores them and the import
works properly.

Editing a Class List
After you create a class list, you can use Teacher Tools to edit it.
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NOTE

You're unable to edit a class list or remove students from it if a class is running.
However, you can add students and import class lists after a class has started.

Editing student information

To edit student
information 1. Start Teacher Tools. SeeStarting Teacher Tools on page 23.

Teacher Tools appears.

2. Select the class from theGradebook area on the left.

3. Click theStudents tab.

The class list appears.

4. Select the student whose information you want to edit.

5. TheProperties tab appears below the class list.

Type the changes into theProperties boxes.

6. Repeat steps 4 and 5 for each student.

Adding students to a Class List

To add a student to a
Class List 1. Start Teacher Tools. SeeStarting Teacher Tools on page 23.

Teacher Tools appears.

2. Select the class from theGradebook area on the left.

3. Click theStudents tab.

TheClass List appears.

4. Click Add on the toolbar.

TheProperties tab appears below theClass List.

5. Type a unique number between 1 and 15 digits in theStudent ID box.

The student information saves to theClass List as you type it.
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6. Type a student's name in theName boxes. The student's e-mail address and tags
are optional. You can also type name and ID information directly in the table.

NOTE

You can use tags to categorize the students in custom groupings that
SMART Response uses when you create student reports. See Tagging
students below.

7. Repeat steps 4 to 6 for each student.

Removing students from aClass List

To remove a student from
a class list 1. Start Teacher Tools. SeeStarting Teacher Tools on page 23.

Teacher Tools appears.

2. Select the class from theGradebook area on the left.

3. Click theStudents tab.

TheClass List appears.

4. Select the student you want to remove, and then click Delete on the toolbar.

5. A message appears asking you to confirm the deletion.

6. Click Yes.

Tagging students
You can use tags to identify groups or categories of students. SMART Response uses
the tags to sort student results when you generate class performance reports. For
example, if you assign the tags “Senior” and “Junior” to the students, SMART Response
adds a chart to the report, with one bar for each of the two tags.

You can assignmultiple tags to a student by separating the tags with a semicolon (;), for
example “Senior;Honors” and “Junior;Honors”. In this case, SMART Response adds a
chart to the report, with three bars (one each for “Senior”, “Junior” and “Honors”).

You can also create tag subcategories by separating the tags with a colon (:). An
example would be “Gender:Male” and “Gender:Female”. In this case, SMART Response
generates a single report section for “Gender” showing data grouped in “Male” and
“Female” subcategories.
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Changing a class's passing grade
When you create a class list, you define the passing grade for the class. You can change
this grade.

To change a class's
passing grade

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23.

Teacher Tools appears.

2. Select the class from theGradebook area on the left.

3. Click Edit (the blue underlined text beside the class name).

TheEdit Class Informationwindow appears.

4. Edit thePassing Grade value, and then click Done.
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About SMART Notebook
Use SMART Notebook software to save notes written on a SMART interactive product
or at your computer as a series of pages. You can use SMART Notebook to create a
presentation full of colorful clip art, graphics, text and Adobe Flash Player compatible
files. Then present that SMART Notebook file, keeping your audience’s attention as you
move and interact with these objects. When your audience provides comments and
suggestions, write their input on a page using the pen tray tools or the pen buttons in
SMART Notebook.

Because SMART Notebook works onmany platforms, you can share files created on a
Windows computer with people who use aMac computer. You can also export your
SMART Notebook file as a cross-platform HTML or PDF file, or as a series of image
files.

SMARTNotebook with SMARTResponse
SMART’s addition of SMART Response software to SMART Notebook means that you
can create question sets, import questions fromMicrosoft Word or XML files and start
and stop question sessions directly from SMART Notebook. You can export the class’s
and individual students’ results to aMicrosoft Excel file or an HTML page. Using
SMART Response’s printing feature, create handout materials, copies of the questions
and graded results pages for each student and for the class. This section introduces the
SMART Response software features in SMART Notebook. For more information about
using other SMART Notebook features, refer to SMART Notebook’s online Help or the
SMART website

Setting SMARTResponse Preferences in SMARTNotebook
You can customize the default behavior of some of SMART Notebook's SMART
Response features.

To define how SMART
Response inserts instant

questions

1. Select Response > Preferences from theSMART Notebook menu bar.

2. Select one of the following options:

o If you want the Insert Question button to insert the question on a SMART
Notebook page that already has notes or images on it, select Insert on the
current page when possible.
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o If you want to create a new page containing your question, select Always
insert on a new page.

o If you want SMART Response to ask you each time, select Always ask
before inserting (default setting).

To define the Response
tab options

1. Select Response > Preferences from theSMART Notebook menu bar.

2. From theDefault chart type for tab results drop-down list, select Pie Chart or Bar
Chart to define the type of results chart you want to display by default.

3. If you want to display theResponse tab immediately after you start an
assessment so you can immediately monitor the progress of the assessment,
select Show the Response tab when you start an assessment.

4. If you want to display theResponse tab immediately after you stop an
assessment so you can immediately display the assessment results, select
Show the Response tab when you stop an assessment.

Creating Assessments
You can use SMART Notebook to create assessments.

Creating an assessment
By creating assessments, you can collect results for each question and for the entire
assessment at the same time. You can define feedback options that show whether
students answered correctly, what the correct answer was and how the class did on the
question or the entire assessment.

You can install SMART Response on any computer to create question sets that you can
later copy to and run on the computer system in your classroom.

NOTE

You're unable to run assessment files on a computer with standard SMART
Notebook software installed. Youmust have SMART Notebook software that
includes SMART Response.

To create an assessment 1. Click theSMART Response icon in theWindows notification area or Mac
menu bar, and then select Open Notebook Software.

A blank SMART Notebook page appears.
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2. Click theResponse tab.

T I P

Clear theAuto-hide option to keep the options visible while you work on
your assessment.

3. Click Title Page.

The Insert Title Page dialog box appears.

4. In the top text box, type a title for your assessment.

5. Select the type of assessment you want to create, and then click Add. Optionally,
you can type Subject and Topic information.

Title page information appears on the SMART Notebook page, and the Response
tab displays several options that allow you to customize your assessment.

To edit the assessment
title page and description

1. On the SMART Notebook page, double-click the title, grade, subject or date text to
change its properties or edit the text.

2. In theDescription area, edit the options you defined when you created the
assessment.

NOTE

If you edit the SMART Notebook page, theDescription information doesn't
change. Similarly, if you edit theDescription information, the SMART
Notebook page doesn't change.

To add question and
content pages to your

assessment

SeeAdding questions to the assessment on page 40 andAdding content pages to the
assessment on next page.

To save your assessment 1. Click .

A Save As dialog box appears.

2. Browse to a folder, type a file name, and then click Save.
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Adding content pages to the assessment
You can add content pages anywhere in your assessment to introduce questions or
provide background information.

To add a content page 1. Create your assessment. SeeCreating an assessment on page 37 for more
information.

2. Click thePage Sorter tab, and then select the page you want to insert a content
page after.

3. Click theResponse tab.

4. Click theNext Steps tab.

5. Click Make the next page a content page.

A blank page appears.

6. Use SMART Notebook's tools to add text, images or Adobe Flash Player
compatible files from theGallery.

Defining feedback options
Feedback options allow you to show your students their individual grades, the correct
answers and the class average.

Feedback
option

Description

After you stop
collecting
responses

The clicker shows how the students answered, and displays their
grade after you click Stop.

After all
questions are
answered

The clicker shows how the students answered, and displays their
grade after they finish answering all questions.

After each
question is
answered

The clicker shows how the students answered after each question,
and displays their grade after they finish answering all questions.

Don't show
grades on
clickers

The clickers don’t show results or grades.
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To define feedback options
1. Create your assessment. SeeCreating an assessment on page 37 for more

information.

2. On theResponse tab for the assessment's title page, select one of the options
described in the table above from theShow grades to students drop-down list.

Adding questions to the assessment
SMART Response supports up to six question types depending on the device students
use to answer questions.

You can add questions to the assessment using the Insert Questionwizard or by
importing questions from aMicrosoft Word document, XML file, SQZ file or PDF file.

After you create a question, you can add choices to it or tag it.

About question types
Using SMART Response, you can ask the following types of questions either
individually or as question sets. You can also add notes to any question type that
appears when you print the question results.

NOTE

l Opinion questions don’t have a correct answer and aren’t worth points. •

l If you include a question of a type not unsupported in the SMART
 Responsemode you are using, the question appears with anUnsupported
Question Type icon in thePage Sorter tab in SMART Notebook.

Question
type

Description Students can answer with

Std. PE LE Notebook
SE

XE

Yes or no Students use theY orN button to
answer a question. You can also
choose theOpinion option to
allow either answer.
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Question
type

Description Students can answer with

Std. PE LE Notebook
SE

XE

True or
false

Students use theTrue or False
button to answer a question. You
can also choose theOpinion
option to allow either answer.

Multiple
choice

Students use a single button, A
through J, to answer the question.
Select from 2 to 10 answers (2 to 5
answers for SMART Response
LE) for a question. You can also
choose theOpinion option to
allow any answer.

Multiple
answer

Students use theA through J
buttons to select the correct
combination of answers to the
question. Select from 2 to 10
answers for the question. You can
also choose theOpinion option to
allow any combination of answers.

Number,
fraction or
decimal

Students use the number buttons
to answer questions with numeric
answers using whole numbers,
fractions or decimals. You can
also choose theOpinion option to
allow any answer.

Text
answer

Students type the answer to the
question. You can choose the
Opinion option to allow any
answer. There is a 20-character
limit on text answer questions.

Number,
fraction,
expression

Students usemath symbols and
numerical values to answer the
question.
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About intelligent expression grading
When you create an expression question and correct answer, intelligent expression
grading accepts multiple representations of that answer expression as correct.

A student’s answer is always graded correct if it:

l matches the question's correct answer exactly

l has a different representation, but is mathematically equivalent and uses the same
terms and operators in the same order as the question's correct answer

You can use intelligent grading options to decide which other mathematically equivalent
answers you’d like to accept as correct. The following graphic shows the three levels of
equivalency that you can define for your questions.

The following table shows examples of how SMART Response's intelligent expression
grading compares expression answers to the question's correct expression answer.
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The following table shows examples of how student answers would be graded depending
on which equivalency option you chose.

Adding questions using the Insert Question wizard
With SMART Notebook, you can ask your students questions and collect their answers.

To add a question using
the Insert Question wizard

1. Click theSMART Response icon in theWindows notification area or Mac
menu bar, and then select Open Notebook Software.

A blank SMART Notebook page appears.
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2. Click Insert Question on the toolbar.

T I P

If Insert Question isn't on the toolbar, you can right-click the toolbar and
add it.

The Insert Questionwizard appears.

3. Click the thumbnail of the question type you want to add, and then click Next.

4. Type the question in the text box.

5. If you use tags to create categories in your reports, type them in the Tags box
using the examples, and then click Next.

6. For yes or no and true or false questions, select the correct answer, or the
Opinion option.

For number, fraction or decimal questions, type the correct answer, or select the
Opinion option.

For multiple choice or multiple answer questions, select the number of answers,
type the answers into the text boxes, click Next, and then select the correct
answers or theOpinion option.

For short answer questions, type one to four acceptable answers or select the
Opinion option.

NOTE

Short answer questions are case-sensitive. You can enter up to four
answers to support different capitalizations (for example, "iron", "Iron" and
"IRON").

For number, fraction, expression questions, use the expression editor to create the
expression question, and then use the editor to create a correct expression
answer.

NOTE

SMART Response's intelligent expression grading feature compares the
student responses to the correct expression answer to determine if it is
eguivalent based on the Intelligent Grading settings you define. See
About intelligent expression grading on page 42 for more information.
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7. Type the number of points the student will receive for a correct answer.

T I P

The value can be a whole or decimal number.

8. If you want to createmore questions, click Insert Another, and then repeat steps
2 to 7.

9. Click Finish.

10. Optionally, use SMART Notebook's tools to add images or Adobe Flash Player
compatible files from theGallery.

Importing questions from aWord document

NOTE

This feature is available only with SMART Response forWindows operating
systems.

When you import questions from aMicrosoft Word document, SMART Response's
conversion utility uses a variety of techniques to identify which paragraphs are
questions, which are possible answers and what type of question to create. Its most
basic technique is to interpret the numbering of the paragraphs. The software also
searches for key words when parsing the paragraphs. The software then converts the
paragraphs into SMART Notebook assessment pages. SeeExampleWord document
question formats on next page for more information.

NOTE

SMART Response is unable to provide the correct answers to the imported
questions.

To import questions from
a Microsoft Word

document

1. Click theSMART Response icon in theWindows notification area or Mac
menu bar, and then select Open Notebook Software.

A blank SMART Notebook page appears.

2. Select Response > Import Question From > Microsoft Word.

TheOpen dialog box appears.

3. Browse to and select theWord document, and then click Open.

A progress bar appears and closes when the conversion is complete.
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4. In thePage Sorter tab, select the thumbnail for the title page.

5. Edit and customize the title page and description as desired.

6. In thePage Sorter tab, select the thumbnail for the first question page and check it
carefully to verify that the conversion process was successful.

7. Repeat step 6 for all questions in the assessment.

To set the answers for
imported questions

1. In thePage Sorter tab, select the thumbnail for the first question page.

2. Select Response > Set All Answers.

TheSet All Answers dialog box appears.

3. Type or select the correct answers from the options, and then click Done.

4. Repeat steps 1 to 3 for all questions.

5. Click .

A Save As dialog box appears.

6. Browse to a folder, type a file name, and then click Save.

You can run the question set on this computer or copy the SMART Notebook file
to any computer that has SMART Response installed.

ExampleWord document question formats
The following list of questions is an example of how to format yourWord document
before importing it into SMART Response.

1. According to the U.S. Census Bureau, themajority of poor children live in:

a. urban areas

b. suburban areas

c. rural areas

2. Can you fill a 10 L aquarium with five 2 L pitchers of water?

Yes

No
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3. True or false: Half of all even whole numbers are divisible by 4.

True

False

4. Let x = 3. Compute y from the equation below.

y = 20 – 4x

Answer: ____________________________

5. Which Native American group lived in the highlighted area on themap?

a. Kwakiutl

b. Sioux

c. Iroquois

NOTE

Ensure that you format the questions in your Microsoft Word document like the
ones in this example before you import the file. In most cases, the import utility
ignores headers and footers in theWord document.

Importing questions from an XML or SQZ file
SMART Response includes an import feature for converting questions from ExamView
format XML files or SynchronEyes software SQZ files into question sets. SMART
Response uses the tags in the XML and SQZ files to extract questions, answers and
correct responses, and then converts the information into assessment pages.

NOTES

l You're unable to run question set SMART Notebook files on a computer
with standard SMART Notebook installed. Youmust have SMART
Notebook software that includes SMART Response software.

l Youmust have or create an ExamView formatted XML text file or a
SynchronEyes software SQZ file before you can perform this procedure.
Binary ExamView formatted files aren't supported.

To import questions from
an XML or SQZ file

1. Click theSMART Response icon in theWindows notification area or Mac
menu bar, and then select Open Notebook Software.

A blank SMART Notebook page appears.
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2. Select Response > Import Question From > XML.

TheOpen dialog box appears.

3. Browse to and select an XML file or a SynchronEyes (SQZ) file, and then click
Open.

A progress bar appears, followed by the title page for the new question set.

4. In thePage Sorter tab, select the first question page.

5. Add a title page to the assessment, and then customize the page and description
as desired.

6. Edit and customize the first question page as desired.

Check the question carefully, including the correct answer (see below), to verify
that the conversion process was successful.

7. Repeat step 6 for all questions in the set.

8. Click .

A Save As dialog box appears.

9. Browse to a folder, type a name for the file, and then click Save.

To set the answers for
imported questions

1. In thePage Sorter tab, select the thumbnail for the first question page.

2. Select Response > Set All Answers.

TheSet All Answers dialog box appears.

3. Type or select the correct answers from the options, and then click Done.

4. Repeat steps 1 to 3 for all questions.

5. Click .

A Save As dialog box appears.

6. Browse to a folder, type a file name, and then click Save.

You can run the question set on this computer or copy the SMART Notebook file
to any computer that has SMART Response installed.
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Importing questions from a PDF file

NOTE

This feature is available only with SMART Response for Mac operating system
software.

When you import questions from a PDF file, the SMART Response conversion utility
interprets the numbering of the paragraphs. The software also recognizes key words
when parsing the paragraphs. The software then converts the paragraphs into SMART
Notebook assessment pages.

NOTES

l You're unable to run assessment files on a computer with standard
SMART Notebook installed. Youmust have SMART Notebook software
that includes SMART Response software.

l Ensure that you format the questions in your PDF file like the ones in this
example before you begin this procedure.

To import questions from
a PDF file

1. Click theSMART Response icon in theWindows notification area or Mac
menu bar, and then select Open Notebook Software.

A blank SMART Notebook page appears.

2. Select Response > Import Question From > PDF File.

TheOpen dialog box appears.

3. Browse to and select the PDF file, and then click Open.

A progress bar appears and closes when the conversion is complete.

4. In thePage Sorter tab, select the thumbnail of the title page.

5. Edit and customize the page and description as desired.

6. Edit and customize the first question page as desired.

7. Check the question carefully to verify that the conversion process was
successful.

8. Repeat steps 6 and 7 for all questions in the assessment.
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To set the answers for
imported questions 1. In thePage Sorter tab, select the thumbnail for the first question page.

2. Select Response > Set All Answers.

TheSet All Answers dialog box appears.

3. Type or select the correct answers from the options, and then click Done.

4. Repeat steps 1 to 3 for all questions.

5. Click .

A Save As dialog box appears.

6. Browse to a folder, type a file name, and then click Save.

You can run the question set on this computer or copy the SMART Notebook file
to any computer that has SMART Response installed.

Adding choices to a question
After you create a question, you can add choices to it.

To add a choice to a
question

1. Click thePage Sorter tab.

2. Select the thumbnail of the question page you want to add a choice to.

3. Select Response > Add Choice.

4. Follow the on-screen instructions.

5. If you have to change the correct answer for the question, select Response > Set
All Answers, and thenmake the changes.

NOTE

If you add choices to true or false; yes or no; number, faction or decimal; or
short or long answer questions, the question changes tomultiple choice.

Tagging questions
Using the Insert Question wizard, you can add tags to the questions you create in
SMART Notebook assessments. You can also add or change the tags to questions after
you finish creating an assessment.
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You can use tags to identify groups or categories of questions. SMART Response uses
the tags to sort responses to questions when you generate Student Performance and
Class Performance reports. For example, if you assign the tags "Difficult" and "Easy" to
the questions, SMART Response creates a chart in the report for questions with
"Difficult" and "Easy" tags.

You can assignmultiple tags to a question by separating the tags with a semicolon (;),
for example, "Science;Nature" and "Science;Astronomy". SMART Response then
generates one chart with three bars for "Science", "Nature" and "Astronomy".

You can also create tag subcategories by separating the tags with a colon (:), for
example, "Science:Basic" and "Science:Advanced". In this case, SMART Response
generates a single report section for "Science" showing data grouped into "Basic" and
"Advanced" subsections.

To add or change tags in
existing questions}

1. Click theSMART Response icon in theWindows notification area or Mac
menu bar, and then select Open Notebook Software.

A blank SMART Notebook page appears.

2. Click File > Open, and then select your assessment file.

The SMART Notebook file appears displaying the title page.

3. Click thePage tab for the question you want to add tags to.

The question page appears.

4. Click theSMART Response tab, and then select theProperties tab.

5. If the Tags box isn't visible, click Show beside theAnswer Key heading.

6. Type your tags in the Tags box. When you finish, click in the whiteboard view.

7. Press Page Up orPage Down to select other questions as required, and then
repeat step 6.

8. Save your assessment

Starting and connecting to a class
To use SMART Response in your classroom, youmust start a class and allow students
to connect to it. You canmonitor the student connections during the class and
disconnect them when the class is done.
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Before Class Begins

Safety Tips for Teachers
When using SMART Response with a SMART Board interactive whiteboard and a
projector:

l Tell students not to look directly at the light beam from the projector. Instead,
encourage them to keep their back to the projector when working at the interactive
whiteboard. Before they turn to face the class, they should take a big step (or even
two) sideways.

l Make sure you don’t look directly into the light beam from the projector. Keep your
back to the class when you write over a projected image. Step to the side of the
interactive whiteboard before you turn to face the class.

l Tell your students not to touch the projector, because it can become extremely hot
during normal operation.

l Don’t use a chair to increase a student’s reach. If your students can’t reach the top
of the interactive whiteboard, lower it. Youmay need to remount a wall-mounted
unit to a lower position. If your interactive whiteboard is mounted on a floor stand,
lower it with the help of another adult.

l Tell students not to run in the vicinity of the floor stand, because they could trip
over the floor stand’s feet.

Starting a class
You can start a class in Sign Inmode or Anonymous mode.

About Sign In and Anonymous modes
Before starting a class session, youmust decide whether you want the system to
operate in Sign Inmode or Anonymous mode. This table summarizes the characteristics
of eachmode.

Sign In mode Anonymous mode
You need to use a class list that identifies
each student by name and ID number.

You can operate the system without a
class list.

Students can connect to the class, but
they must sign in with their assigned ID
number.

Students can connect to the class without
identifying themselves.

Teachers can control when students can
sign in by locking a class.

Teachers can't control when a student can
sign into their class.

Under the teacher's control, students can
see their own grades, but they're unable to
see any other students' grades.

Under the teacher's control, students can
see their own grades, but they're unable to
see any other students' grades.
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Sign In mode Anonymous mode
If the Remember names check box is
selected, teachers can identify individual
students as they connect to the class.

Teachers can see how many students are
connected.

Teachers can useGradebook to save and
analyze student and class performance
over time.

Teachers are unable to save and analyze
student and class performance over time.

Teachers can generate student and class
reports.

Teachers are unable to generate student or
class performance reports.

Teachers can see, export and print the
total class grade.

Teachers can see, export and print the
total class grade.

Teachers can see, export and print total
scores for each question.

Teachers can see, export and print total
scores for each question.

Teachers can see, export and print each
student's grade for each question and for
the whole assessment.

Teachers are unable to identify student
names or individual grades.

Teachers can review results during the
assessment in the Response tab for the
class as a whole and for individual
students (if the Remember names check
box is selected).

Teachers can view results for the class as
a whole during the assessment in the
Response tab.

Starting a class in Sign In mode
When you use SMART Response in Sign Inmode, you canmonitor each student’s
responses, and create reports on student and class performance. For more information,
seeAbout Sign In and Anonymous modes on previous page

NOTE

Before you can start a SMART Response class and have students connect in
Sign Inmode, youmust have a class list. If you don't have a class list, you can
create or import class lists.

To start a class in Sign In
mode

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23

Teacher Tools appears.

2. Select the class in theGradebook area on the left, and then click Start Class.

The receiver’s power LED light flashes and then turns solid green, and the
receiver's Transmit LED light flashes green. You can now ask the students to turn
on and connect to the class.
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Starting a class in Anonymous mode
You don't need aClass List to operate SMART Response in Anonymous mode. See
About Sign In and Anonymous modes on page 52 for more information.

To start a class in
Anonymous mode

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23

Teacher Tools appears.

2. Select Anonymous Mode in theGradebook area on the left, and then click Start
Class.

The receiver’s power LED light flashes and then turns solid green, and the
receiver's Transmit LED light flashes green. You can now ask the students to
connect to the class.

NOTES

l If the students have already signed in to a class, and you select
Anonymous Mode, the clickers switch to Anonymous mode.

l If the clickers are in Anonymous mode, and you start a class that requires
sign-in, the clickers sign off and then ask the students to sign in.

Connecting clickers to the class
After you start a class, you can tell your students to connect to the class.

The student's connection process depends on SMART Response software's current
mode. In addition, you can prevent students and clickers from signing in.

Connecting in Anonymous mode
Youmust start a class in Anonymous mode before your students connect their clickers.
SeeStarting a class in Anonymous mode above

NOTE

In this mode, students must know the class name.

When the “SMART Response is ready to use” balloonmessage appears, tell your
students to follow this procedure.
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To connect in Anonymous
mode 1. Press the clicker's Power button for one second.

A message appears asking if you want to join the last class the clicker was
connected to, or find a different class.

2. Press theEnter button to join the last class.

OR

Press theDown button to select Find a class, and then press Enter.

The clicker scans for classes, and then displays a list of classes within range.
Press theUp andDown buttons to select the correct class, and then press Enter.

3. Press theEnter button to connect.

Ask the students to press their clicker's Power button for one second.

A "Hello" message appears on the clicker display.

NOTES

l If the teacher selected the Lock Sign In option, the clicker displays a “Fail
to login” message.

If this occurs, unlock Sign In, and then tell the students to press Enter.

l When all of your students are connected, you can start asking questions.
Refer toCreating Assessments on page 37 for information about using
SMART Notebook to ask questions and create assessments

Connecting in Sign In mode
Youmust start a class in Sign Inmode before your students connect their clickers. See
Starting a class in Sign Inmode on page 53.

NOTE

When connecting to a class in Sign Inmode, students must know the classroom
name. They must also sign in with a unique ID number.

After you start a class, ask your students to follow these steps.
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To connect in Sign In
mode 1. Press the clicker's Power button for one second.

A message appears asking if you want to join the last class the clicker was
connected to, or find a different class.

2. Press theEnter button to join the last class.

OR

Press theDown button to select Find a class, and then press Enter.

The clicker scans for classes, and then displays a list of classes within range.
Press theUp andDown buttons to select the correct class, and then press Enter.

A connectingmessage appears, followed by amessage asking for an ID number.

3. Press the number buttons to enter your ID number, and then press Enter.

If you've entered a valid ID, amessage appears asking you to confirm your name.

NOTE

If the teacher selected the Lock Sign In option, amessage appears on the
clicker indicating that the student can't sign in at this time, and then aRetry
option appears.

4. Press theEnter button to connect.

A welcomemessage appears.

When all of your students are connected, you can start asking questions. Refer to
Creating Assessments on page 37 for information about using SMART Notebook to ask
questions and create assessments.

NOTE

If a student attempts to sign in using an ID that another student is already using,
the clicker displays amessage indicating that they are unable to sign in and
allows them to retry.

Locking Sign In
You can block students from signing in to your class. Select the Lock Sign In button to
block students from signing in before you're ready or to block late students from signing
in. When you start a class, Sign In is unlocked by default. If you stop and restart SMART
Response or open a new class list, Sign In is unlocked.
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NOTE

Sign-in locking is available only in Sign Inmode.

To block students from
signing in

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23

Teacher Tools appears.

2. If a class isn't already started, select a class in theGradebook area, and then click
Start Class.

3. Click Lock Sign In.

Students are unable to sign in.

NOTE

If students disconnect from your class when sign-in is locked, they're unable to
sign in again until you select Unlock Sign In.

Monitoring clickers
You can use Teacher Tools to check the status of each clicker. You can see if a clicker
is logged on or if it's in Anonymous mode. If the clicker is logged on, you can also see the
student's name. You can see the clickers' serial numbers (MAC address) and identify
which logged-on student is using it.

The display shows the signal strength of each clicker, as measured by the receiver. If
the signal level is low for one or more clickers, and they are having communication
problems, youmay want to reposition the receiver or remove signal path obstructions.

To monitor clickers 1. Start a class and have your students connect their clickers.

The SMART Response receiver LED lights are green.

2. Start Teacher Tools. SeeStarting Teacher Tools on page 23

Teacher Tools appears.
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3. Click theDevices button in the left column.

TheDevices window appears and displays a "Your SMART Response receiver is
connected and working" message. The receiver name appears below theDevices
button.

NOTE

If a "Your SMART Response receiver is not connected" message appears,
the SMART Response receiver isn't connected or isn't working properly.
Check the receiver connections or repeat the receiver installation.

4. Click My Receiver, and then click theClickers tab at the top of the window.

TheClickers window appears and displays a table of all connected clickers. Each
row of the table shows one clicker's signal strength, battery condition, student
name and hardware ID (MAC address).

NOTE

If students' clickers are connected anonymously, theStudent Name field
displays Anonymous.

Disconnecting students from a class
You can disconnect the clickers from a class in three ways.

Disconnecting all students using Teacher Tools
You can disconnect and turn off all students simultaneously.

To disconnect all students
using Teacher Tools

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23

Teacher Tools appears.

2. Select the class in theGradebook area on the left, and then click Stop Class.

All student clickers disconnect.

A message appears on the clickers indicating that the class is over and that the
clickers are turning off. The Transmit and Receive LED lights on the receiver turn
off and the Ready LED light turns red.

To disconnect all clickers
using the Devices menu

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23

Teacher Tools appears.
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2. Select Devices, and then click Turn off all clickers.

All student clickers disconnect and turn of.

A message appears on the clickers indicating that the class is over and that the
clickers are turning off. The Transmit and Receive LED lights on the receiver turn
off and the Ready LED light turns red.

Disconnecting individual clickers using Teacher Tools

NOTE

This option is available only if the students are connected to a class in Sign In
mode.

To disconnect individual
clickers using Teacher

Tools

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23

Teacher Tools appears.

2. Select the active class in theGradebook area.

3. Click theStudents tab.

4. Select the row of the student you want to disconnect.

TheProperties window appears below the student list table.

5. Click Disconnect Clicker at the top-right of the window.

The LogOff Student dialog box appears.

6. Click OK to log off the student.

NOTE

The student can log back on immediately.

OR

If you don't want the student to be able log on for a while, select Also ban this
student for, select the number of minutes, and then click OK.
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Students disconnectingmanually
Students can disconnect their clickers by pressing thePower button for one to two
seconds.

If signed-in students turn off their clickers when a question set is started, they can turn
on the clickers, sign in with the same ID and rejoin the assessment in progress without
losing any previous answers. If a student is connected anonymously, they lose any
previous answers when they reconnect.

If students connect to the wrong class, ask them to log off by pressing theMenu button,
selectingSign out and pressing theEnter button.

They can then connect and sign in to the correct class without turning off their clickers.

Using clickers
After students connect their clickers to your class, they can use their clickers to
complete assessments.

In addition, students can ask questions using their clickers and change the clicker
settings.
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About XE clickers

Button/key name Key Function

Power button Press and hold to turn clicker on or off

Soft keys Press to select functions displayed on the LCD
display. The functions depend on the clicker's
mode
Press to answermultiple choice, multiple
answer, true/false and yes/no questions

Letter and number
keys

Press to insert lowercase value
Press Shift key and then press to insert
uppercase value
Press and hold a, e, i, o, u, y, c or n keys to
select other character variations

Symbol key Press and release to select green key functions
Press and hold to display amenu where you
can select symbols
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Button/key name Key Function

Spacebar/Menu
button

Press to add a space in text or mathematical
expressions
Press after pressing theSym key to display a
menu where you can select Raise hand,
Symbols or other functions depending on
clicker mode.

Directional
keypad

Press to navigatemenu options or navigate text
andmathematic expression content

Shift key Press and then press keyboard key to enter an
uppercase character

Math expression
keys–fraction

Press to insert fractional values in an
expression

Math expression
keys–root

Press to insert a square root value in an
expressions
Press after pressing theSym key to insert a
radicand

Math expression
keys–
superscript/subscript

Press to insert a superscript value in an
expression
Press after pressing theSym key to insert a
subscript value in an expression

Asking questions
At any time during a class, a student can request the teacher's attention by pressing the
Sym button, pressing the spacebar and then selectingRaise hand on their clicker.
Teacher Tools displays the number of students who have questions on theHome tab
beside theQuestions heading.

To identify students with
questions

1. Click theStudents tab to show the list of student names and IDs.

2. In theStatus column, youmay see one or more rows with a question icon .

3. After you answer the student's question, select the row that displays the student
name, and then click Clear Question in the top-right corner of theProperties
window.
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Completing assessments
After you create an assessment, you can start it in SMART Response. Students then
complete the assessment using their clickers. During the assessment, you can view
results.

Starting an assessment
When you use SMART Notebook to ask questions, SMART Response uses the options
you set in Teacher Tools to control how students use their clickers. Before starting a
SMART Response assessment, check that the receiver is connected and ready. If you
don’t have a SMART Notebook assessment file, youmust create one. SeeCreating an
assessment on page 37 for more information.

To open and set
assessment options

1. Click theSMART Response icon in theWindows notification area or Mac
menu bar, and then select Open Notebook Software.

A blank SMART Notebook page appears.

2. Select File > Open.

3. Select the SMART Notebook file containing your questions, and then click Open.

The assessment file's title page appears.

4. Click theResponse tab, and then click Properties, if it isn't already selected.
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5. Select theRemember names check box to display student names in the
Response tab during the assessment.

OR

Clear theRemember names check box to not display student names in the
Response tab during the assessment.

NOTES

o Select theRemember names check box if you want to identify
students when reviewing results during the assessment.

o Clear theRemember names check box if you want to display the
SMART Notebook file on a SMART Board interactive whiteboard
during the assessment but don't want students to see each other's
results. (You can review, print and export the results after the
assessment even if you clear theRemember names check box.)

6. From theShow results to students drop-down list, select one of the following
options:

Feedback
option

Description

After you stop
collecting
responses

The student can see how they answered after you click Stop.

After all
questions are
answered

The student can see how they answered after they finish
answering all questions.

After each
question is
answered

The student can see how they answered after each question,
and they can see their grade after they finish answering all
questions.

Don't show
grades on
clickers

The student can't see their results or grades.

To start an assessment
and ask questions

1. If you haven't started a class, start it now.

2. If the students haven't connected to the class, have them do so now.
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3. Select Response > Start Assessment,

OR

Click Start this assessment now.

TheResponse tab opens with theProgress button selected.

If you’re projecting the questions on a screen, you can control the students’
progress by selecting each question page in turn.

4. Use themenu bar Forward or Back buttons to open a question page.

OR

Click thePage Sorter tab, and then select the thumbnail of a question page.

5. Click Stop this assessment in theResponse tab.

OR

Click Stop Assessment in themenu bar to end the session.

6. If you chose to show results to students, select Response > End Review Mode
when the students are done reviewing their results.

7. Click to save the results.

Collecting question responses

NOTE

Make sure that you start your class and that all the students are connected before
you ask questions.

To collect question
responses

1. Click Response > Start Assessment.

If you haven’t started a class, amessage appears asking you to select a class.
Select a class, and then click Start Class.

A message appears on the clickers asking the students to respond.

2. When all students have answered, click Response > Stop Assessment.

NOTE

SMART Notebook stores the results in your document. Remember to save
your document after collecting responses.
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3. If you want to save the questions as a SMART Notebook file, click File > Save (or
Save As).

A Save As dialog box appears.

4. Browse to a destination folder, type a file name, and then click Save.

Reviewing results during an assessment
You can use SMART Response to collect and display results instantly while you run an
assessment. You can use assessments as an interactive learning tool and a way to give
students continual feedback about what they're learning.

To display instant class
assessment results

1. After all students answer the questions, return to the assessment's title page.

2. Click SMART Notebook's Response tab if it isn't already open.

3. Click Progress, and then click Stop this assessment.

TheProgress button changes toResults. A summary of the class's performance
appears, including a chart showing the class's responses to each question.

4. If you want to view more detailed class results, click Show besideDetails.

A list of students, their grades and the duration of the assessment appears.

NOTES

o Use discretion when displaying sensitive grade information to all
class members. If you started the class in Sign Inmode, consider
clearing the Remember names check box before you start the
assessment to not display student names in the Response tab. (You
can later review, print and export the results in Teacher Tools.)

o If you started the class in Anonymous mode or cleared the
Remember names check box before you start the assessment,
student names display as Anonymous-1, Anonymous-2, and so on.

To display instant results
for each question

1. After all students answer the questions, return to the assessment's title page.

2. Click SMART Notebook's Response tab if it isn't already open.

3. Click Progress, and then click Stop this assessment.

TheProgress button changes toResults. A chart representing the class's
performance appears.

| C H A PT ER 4 – U S I N G SMAR T  R ESPON SE



6 7

4. Click thePage Sorter tab, and then select a question.

5. Click theResponse tab.

6. Click Results.

A summary of the class's responses to the question appears, including a chart
showing the number of responses to each possible answer.

NOTE

You can toggle the type of chart displayed by selectingShow bar chart or
Show pie chart.

T I P

You can insert the chart into the question page by clicking Insert chart
into Notebook.

7. Click Show besideDetails.

A list showing each student's submitted response appears, including the time it
took them to respond.

NOTES

o Use discretion when displaying sensitive grade information to all
class members. If you started the class in Sign Inmode, consider
clearing theRemember names check box before you start the
assessment to not display student names in the Response tab. (You
can later review, print and export the results in Teacher Tools.)

o If you started the class in Anonymous mode or cleared the
Remember names check box before you start the assessment,
student names display as Anonymous-1, Anonymous-2, and so on.
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Reviewing, printing and
exporting assessment
results
The Teacher Tools Gradebook gives you quick access to test results, making it easy to
prepare reports and conduct evaluations. Reports can be as simple or as detailed as you
need. Create high-level comparisons of class performance, specific reports based on
tagged characteristics such as demographics or curriculum standards, or personalized
reports on how individual students perform. You can also create reports that show
grades for the entire school year.

NOTE

Assessment results for students aren't saved in Anonymous mode.

You can display results and generate reports to review during an assessment or after you
run an assessment.

In addition, you can print or export questions and assessment results.

I N TH I S SECT ION
Importing assessment results 70

Formatting the results files for importing 70
Importing a class results file 70
CSV and XLS File Formatting 71

Reviewing assessment results 71
Generating student performance reports 74
Generating class performance reports 75
Printing and exporting questions and results 75

Printing from Notebook's Responsemenu 76
Exporting Results to an Excel, HTML or CSV file 77
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Importing assessment results
You can import the results of an assessment that you performed without SMART
Response. You can then generate reports combining the results from your assessments
with the imported results.

You can import results using either comma separated values (CSV) files or Microsoft
Excel files (Windows only).

NOTE

The ID numbers you use in the list you import must match the ID numbers
assigned to the students in the class list that you're using.

Formatting the results files for importing
Youmust use the headings ID Number andMarkswhen you format the .csv, .xls or
.xlsx files for importing. If you're using information from another program, copy it to a new
file and then format it as shown in this example.

Importing a class results file

To import a class results
file 1. Start Teacher Tools. SeeStarting Teacher Tools on page 23.

Teacher Tools appears.

2. In theGradebook area, select the class you want to import the results to.

3. Click Import on themenu bar, and then select Assessments.

4. Click the target class, and then click Next.

5. Click theStudents tab at the top of the window.

6. Type the title, and then select the type of the assessment. Optionally, you can
type the subject and topic information.

7. Select thePercentage orRaw values score formats, and then click Next.

8. Select the file type, and then click Next.

9. Browse to the file location, and then click Open.

The student results information appears in theStudents tab and in the
Assessments tab. You can also generate reports that include the imported scores.
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CSV and XLS File Formatting
EXAMPLE

Comma separated value (CSV) file

EXAMPLE

Excel spreadsheet (XLS) file

Reviewing assessment results
After you run and stop an assessment, Teacher Tools records the class results and each
student's results. At any time after you run an assessment, you can review the student,
question or assessment results and performance.
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NOTE

Use discretion when displaying sensitive information to all class members. To
hide sensitive information, click thePrivacy: Off icon before you display student
or assessment results. SeeAdjusting Privacy and Alert options on page 25 for
more information.

To display student results 1. If a class is currently running, stop it.

2. In Teacher Tools, select the class name in theGradebook area.

The Teacher Tools window appears with theHome tab selected.

3. Click theStudents tab.

After a short delay, a table of results appears. If you previously turned on Privacy
mode, the student IDs and statistics appears as gray shapes in the table.

4. If Privacy mode is on, click Privacy: Off .

The first columns of the table of class results show the student name, ID and
average score for all the assessments the student has participated in. The
columns that follow show each student's results for every assessment the class
has participated in.

To display detailed results
for each student

1. Complete the above procedure, and then select the student's row.

The student's information appears in the lower pane.

2. Click thePerformance tab.

AnAssessment Results over Time graph appears showing the student's results
compared to the class average for all assessments since the first assessment
was run.

NOTE

The graph is hidden while Teacher Tools is in Privacy mode.

3. Place your pointer over the graph to display details about the specific assessment.
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4. Click theResults tab.

A table appears showing detailed information about each assessment the student
has participated in, including the date and the score the student achieved. If the
student's score is below the passing grade you defined when you created the
class, the score appears in red. SeeChanging a class's passing grade on page 33
for information.

To display class
assessment results

1. If a class is currently running, stop it.

2. In Teacher Tools, select the class name in theGradebook area.

The Teacher Tools window appears with the Home tab selected.

3. Click theAssessments tab.

After a short delay, a table of results appears listing all assessments that the class
has participated in, including the class average score for each assessment. If the
class average score is below the passing grade you defined when you created the
class, the score appears in red. SeeChanging a class's passing grade on page 33
for information.

To display detailed results
for each assessment

1. Complete the previous procedure, and then select the assessment's row.

The lower pane of the window displays the assessment's properties.

2. Click thePerformance tab.

A Student Achievement per Question graph appears showing the student
responses to each question.

NOTE

The graph is hidden while Teacher Tools is in Privacy mode.

3. Place your pointer over the graph to display details about the specific questions.

4. Click theResults tab.

A table appears showing themark each student received for the assessment. If
the student's score is below the passing grade you defined when you created the
class, themark appears in red.

| C H A PT ER 5 – R EV I EW I N G , PR I N T I N G AN D EXPOR T I N G ASSESS -

MEN T R ESU L T S



7 4

Generating student performance reports
You can generate student performance reports at any time after your assessments are
complete. You can tailor the reports to include all classes or select classes. You can
also create reports for individual students or for all students in the selected classes at
one time.

To generate a student
performance report

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23.

Teacher Tools appears.

2. In theReports area, click Student Performance.

TheStudent Performance Report window appears.

3. In theClass drop-down list, select the class you want a report for.

OR

Select All classes for a report on all classes.

4. In theStudent drop-down list, select the student you want a report on.

OR

Select All students for a report on all students.

5. Define theReport Period if you want a report for a specific range of dates.

6. In the Include drop-down list, select Selected assessment types orAll
assessment types.

7. If you choseSelected assessment types, select the types you want a report for
from the check list that appears.

8. Browse to where you want to save the report file, and then click Create.

SMART Response creates one or more reports as PDF files that appear in your
default PDF viewer. The files are named using the student name and ID, and the
date the files are created.

If you generated one report, the report opens automatically. If you generated
multiple reports, the report's folder location appears inWindows Explorer or Mac
Finder.

| C H A PT ER 5 – R EV I EW I N G , PR I N T I N G AN D EXPOR T I N G ASSESS -

MEN T R ESU L T S



7 5

Generating class performance reports
You can generate class performance reports at any time after your assessments are
complete. You can tailor the reports to include all classes or select classes. You can
also create reports on all assessment types or on specific types of your choice.

To generate a class
performance report

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23.

Teacher Tools appears.

2. In theReports area, click Class Performance.

TheClass Performance Report window appears.

3. In theClass drop-down list, select the class you want a report for.

OR

Select All classes for a report on all classes.

4. Define theReport Period if you want a report for a specific range of dates.

5. In the Include drop-down list, select Selected assessment types orAll
assessment types.

6. If you choseSelected assessment types, select the types you want a report for
from the check list that appears.

7. Browse to where you want to save the report file, and then click Create.

SMART Response creates one or more reports as PDF files that appear in your
default PDF viewer. The files are named using the class name and ID, and the
date the files are created.

If you generated one report, the report opens automatically. If you generated
multiple reports, the report's folder location appears inWindows Explorer or Mac
Finder.

Printing and exporting questions and
results
Using SMART Notebook's Responsemenu, you can create hard copies of questions,
handouts and student results. You can also export question and student results to an
Excel spreadsheet, comma separated values (CSV) file or an HTMLweb page.
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Printing from Notebook's Responsemenu
You can print a variety of information from theResponsemenu in SMART Notebook
software. You can create and include header, footer and date information, and select a
page range to print.

Print option Description

Thumbnails On one page, print up to six full-color, reduced images of each
SMART Notebook title page and question page. You can include
page numbers, image borders and page titles.

Handouts On one page, print up to three full-color, reduced images of each
SMART Notebook title page and question page, with ruled lines
for notes. You can include page numbers, image borders and
page titles.

Full page On one page, print a full-color image of each SMART Notebook
question page. You can include page numbers.

Questions Print several questions on a page. If the question page doesn't
have any objects or images, only the text appears. If there are
objects on the question page, a full-color thumbnail of the
question appears. You can include page numbers.

Results NOTE

This option is available only after you stop an
assessment.

Print several questions on a page. If the question page doesn't
have any objects or images, only the text appears on the page. If
there are objects on the question page, a full-color thumbnail of
the question appears. In the Print Preview view, you can click
the question to toggle from thumbnail to text-only format.
The correct answer and the student’s response appear beside
each question, and the total score appears at the top of the first
page. You can include page numbers.
You can print a summary of the results for all students in the
class list, or you can print the results for selected students.

To print questions or
results

Click Response > Print, and then select the option you want to print.

OR

For other options, click Response > Print > More Print Options, or press CTRL+P
(Windows) orCMD+P (Mac OS X) to open SMART Response's print window.
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NOTE

TheQuestions and Results print options are available only if the SMART
Notebook file includes SMART Response questions and saved results
information. If the assessment is still running, or if it stops before any student
answers a question, no results are saved.

Exporting Results to an Excel, HTML or CSV file
If you save your SMART Notebook file after you ask questions, or after you run an
assessment, you can open the SMART Notebook file at any time to view the results.

You can export the results to an Excel spreadsheet (Windows), to an HTML page for
viewing on a web browser or to a comma separated values (CSV) file that you can import
into many spreadsheet and database applications. SeeCSV and XLS File Formatting on
page 71.

NOTE

You can export results only after you stop the assessment. If you clear the
results after you stop, the results are permanently deleted and you're unable to
print or export them. After you save and close the SMART Notebook file, you can
open the file and print or export the results.

To export results from
Teacher Tools

1. Start Teacher Tools. SeeStarting Teacher Tools on page 23.

Teacher Tools appears.

2. Select File > Export from themenu bar.

TheExport dialog box appears.

3. In the list, select the class with the results you want to export, and then click Next.

4. Select theBy student option if you want to export results for your entire class (the
default selection) or for an individual student. If you want to export results for an
individual student, also select the student's name from the drop-down list.

OR

Select theBy assessment option if you want to export the results of a class
assessment or all assessments the class has taken.

5. Click Next.
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6. Select the format you want to export the results in, and then click Next.

A Save As dialog box appears.

7. Browse to a folder, type a name for the file, and then click Save.

The results export and open in your computer's default file viewer.

To export results from
SMART Notebook

1. Stop the assessment if it's still running.

Don't clear the results.

2. In SMART Notebook, select Response > Export results to > Microsoft Excel.

NOTE

Exporting toMicrosoft Excel isn't available onMac computers.

OR

Click Response > Export results to > Web Page (HTML).

OR

Click Response > Export results to > Comma Separated Values (CSV).

A Save As dialog box appears.

3. Browse to a folder, type a file name, and then click Save.

Either Excel or your default web browser opens, showing the exported file.
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Preventing component damage
CAUTION

l Do not use sharp or pointed objects, such as ballpoint pens or pointers, to
press the clicker buttons.

l Never use abrasive erasers or harsh chemicals while cleaning the receiver
or clickers.

l Avoid setting up and using your system in an area with excessive levels of
dust, humidity or smoke.

Chapter 6



8 0

Cleaning the receiver and clickers
With proper care, your SMART Response hardware will provide years of trouble-free
service. Follow these cleaning tips tomaintain your SMART Response system:

l Remove dust with a damp cloth before using a cleaner.

l Clean the unit’s surface with a household glass cleaner, such as Windex®, daily,
weekly or as required.

l Do not spray cleaner directly onto the clicker. Instead, spray a light amount of
cleaner on a cloth and then gently wipe the clicker.

Transporting SMARTResponse
If you need to ship your SMART Response hardware, repack it with as much of the
original packaging as possible. If you prefer to use your own packagingmaterials, make
sure you adequately protect the product.

Changing clicker batteries
Under normal operating conditions, the clicker batteries can operate for up to 200 days.
When replacing them, use fresh batteries of the same type and quality, and change both
at the same time.

CAUTION

l Do not install batteries with the polarity (+/–) reversed.

l Do not attempt to recharge the batteries.

l Do not dispose of batteries in a fire or incinerator.

l Dispose of batteries according to your region’s laws and regulations. If you
don’t know the applicable rules for your region, consult your battery
manufacturer.

To change the clicker
batteries

1. If the clicker is on, turn it off.

2. Using the included Phillips® screwdriver, remove the screw from the back of the
clicker, and then remove the cover.

3. Remove the exhausted batteries, and dispose of them according to local
regulations.
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4. Insert new AA batteries.

5. Replace the cover and screw.

Resetting clickers
If your clicker isn't operating as expected, youmay need to reset it. Perform the following
steps to reset it.

To reset the clicker 1. If the clicker is on, turn it off.

2. Using the included Phillips® screwdriver, remove the screw from the back of the
clicker, and then remove the cover.

3. Remove the batteries.

4. Press and hold the Power button for at least 5 seconds.

5. Replace the batteries.

6. Replace the cover and screw.

Receiver indicator lights
Receivers have the following LED indicator lights:

l The Ready light

l The Transmit light

l The Receive light

The Ready light is in the upper-right corner of the receiver. The Ready light indicates the
operational states of the receiver module. You can see the Transmit and Receive lights
in the lower-right part of the receiver. The lights flash green, indicating transmit and
receive activity between the receiver and the clickers.

The following table shows the Ready light’s normal states. If the light’s behavior doesn’t
match a state listed here, refer to Troubleshooting the receiver on next page.

Ready Light
State

Description

Off The receiver is disconnected from the computer.
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Ready Light
State

Description

Solid red The receiver has power, but either it isn’t communicating with the
computer or no class is started.

Solid green The receiver is receiving power and communicating successfully with
SMART Response software.

Troubleshooting the receiver
Do not open the receiver or the clicker units to attempt repairs. Refer all service inquiries
to authorized SMART service personnel.

Resetting the Receiver
If your SMART Response software behaves erratically (possibly because of a static
discharge or power fade), youmight be able to restore normal operation by resetting the
receiver.

Reset the receiver completely by disconnecting and then reconnecting the USB cable.

Troubleshooting Using the Receiver LED Lights
If you experience a problem with your receiver, you can use the receiver LED lights to
troubleshoot it.

Ready
Light

Transmit
Light

Receive Light Receiver State

Red,
green
yellow

Green Green Receiver is starting up. Lights flash in
sequence.

Flashing
green

Off Off Receiver is scanning radio channels.

Flashing
green

Any state Any state Receiver is accepting commands from the
computer.

Green Constant
flashing

Flashes when it
receives data from
a clicker

Receiver has power and is communicating
with the computer, but isn’t receiving
commands.

Yellow Off Off Receiver has power, but communication
circuits have failed.
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Ready
Light

Transmit
Light

Receive Light Receiver State

Flashing
red

Flashing Flashing Manufacturing tests running, and receiver
isn’t operational. All lights flash together.

Flashing
yellow

Any state Any state Receiver software checksum failed.

Flashing
yellow

Flashing Flashing Receiver software failure.

Other troubleshooting tips
Symptom/Observation Action/Remedy

When you export SMART
Response question set results
from a SMART Notebook file
using the CSV command,
fractions change to dates.

In your exported results convert the exported dates
to fractions, add a space before each fraction and
convert themonth to its numerical value. The
convertedmonth is the fraction’s numerator, and
the day is the denominator.

Your computer doesn’t recognize
SMART Response, and the
receiver’s Status LED light
remains solid red.

Remove the SMART Response hardware drivers
on your computer, and then reconnect the receiver
following the instructions in document 115401.

Responses from students don’t
appear in SMART Notebook
reports.

Wait at least 10 seconds after the last student
responds before you stop a question set.

Additional SMART Response
receivers don’t connect to the
network when you install more
than one receiver on your
computer.

Disconnect the additional receiver’s USB plug to
resume normal operation. • Install only one receiver
per computer. • Disconnect and reconnect the first
receiver’s USB plug if it doesn’t work, or if the LED
light turns red.

NOTE

Installingmore than one receiver affects
your computer’s performance and doesn’t
increase your reception.

During the installation of a
SMART software product on the
Windows operating system, a
dialog box appears informing you
that the installation was
interrupted.

To prevent interruptions, restart the computer, and
follow the procedure outlined in document 77681.
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Hardware environmental
compliance
SMART Technologies supports global efforts to ensure that electronic equipment is
manufactured, sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment
Regulations (WEEE directive)
Waste Electrical and Electronic Equipment regulations apply to all electrical and
electronic equipment sold within the European Union.

When you dispose of any electrical or electronic equipment, including SMART
Technologies products, we strongly encourage you to properly recycle the electronic
product when it has reached end of its life. If you require further information, please
contact your reseller or SMART Technologies for information on which recycling agency
to contact.

Restriction of Certain Hazardous
Substances (RoHS directive)
This product meets the requirements of the European Union’s Restriction of Certain
Hazardous Substances (RoHS) Directive 2002/95/EC.

Consequently, this product also complies with other regulations that have arisen in
various geographical areas, and that reference the European Union’s RoHS directive.

Batteries
Batteries are regulated in many countries. Check with your reseller to find out how to
recycle used batteries.
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There are special regulations that must bemet when shipping a product that has a lithium
ion battery packaged with the product or shipping a lithium ion battery. When returning a
SMART Technologies product which contains a lithium ion battery or returning a lithium
ion battery, call SMART Technologies RMA for information on these special shipping
regulations:

l 1.866.518.6791, Option 4 (U.S./Canada)

l 1.403.228.5940 (all other countries)

Packaging
Many countries have regulations restricting the use of certain heavy metals in product
packaging. The packaging used by SMART Technologies to ship products complies with
applicable packaging laws.

Covered Electronics Devices
Many U.S. states classify monitors as Covered Electronic Devices and regulate their
disposal. Applicable SMART Technologies products meet the requirements of the
Covered Electronic Devices regulations.

China’s Electronic Information Products
regulations
China regulates products that are classified as EIP (Electronic Information Products).
SMART Technologies products fall under this classification andmeet the requirements
for China’s EIP regulations.

U.S.Consumer Product Safety
Improvement Act
The United States has enacted theConsumer Product Safety Improvement Act which
limits the lead (Pb) content in products used by children. SMART Technologies is
committed to complying with this initiative.
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California Air Resource Board – Airborne
Toxic Control Measure
California has enacted a law to restrict the emissions of Formaldehyde from Composite
Wood Products. The SMART Technologies products that contain CompositeWood
Products are compliant to this regulation.

Restriction of Certain Chemicals (REACH
directive)
The European Union has enacted the EU REACH Directive which restricts the use of
certain chemicals in products. SMART Technologies is committed to complying with
this initiative.
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Customer support

Online information and support
Visit www.smarttech.com/support to view and download user’s guides, how-to and
troubleshooting articles, software andmore.

Training
Visit www.smarttech.com/trainingcenter for trainingmaterials and information about our
training services.

Technical support
If you experience difficulty with your SMART product, please contact your local reseller
before contacting SMART Support. Your local reseller can resolvemost issues without
delay.

NOTE

To locate your local reseller, visit www.smarttech.com/where.

All SMART products include online, telephone, fax and e-mail support:

Online www.smarttech.com/contactsupport

Telephone +1.403.228.5940 or
Toll Free 1.866.518.6791 (U.S./Canada)
(Monday to Friday, 5 a.m. – 6 p.m. Mountain Time)

Fax +1.403.806.1256

E-mail support@smarttech.com

Shipping and repair status
Contact SMART’s Return of Merchandise Authorization (RMA) group, Option 4,
+1.866.518.6791, for shipping damage, missing part and repair status issues.
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General inquires
Address SMART Technologies

3636 Research Road NW
Calgary, AB T2L 1Y1
CANADA

Switchboard +1.403.228.5940 or
Toll Free 1.866.518.6791 (U.S./Canada)

Fax +1.403.228.2500

E-mail info@smarttech.com

Warranty
Product warranty is governed by the terms and conditions of SMART’s “Limited
Equipment Warranty” that shipped with the SMART product at the time of purchase.

Registration
To help us serve you, register online at www.smarttech.com/registration.
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